
Ch.7 Finite element formulation of plane stress plasticity 
 
     In [1], we stated the basic FEM procedures to deal with the elastic-plastic problem applicable to the 
general three-dimensional state of stress, plane strain, and an axisymmetric body. These problems are 
those in which all three components of the normal stress are free variables. However, in plane stress, the 
component perpendicular to the midplane of the body is equal to zero, but the component of the stress 
deviator in this direction is not zero, and these relationships cannot be used for this case without  
modification. 
 
7.1  Plane stress linear elasticity 

     The plane stress assumption was introduced in the analysis of bodies in which one dimension was 
significantly smaller than the other dimensions. Consider a loaded body in equilibrium (Fig. 1), where the 
plane (x, y) is the plane of symmetry (midplane S) of the body. Let all external loads (including reactions) be 
distributed symmetrically to the relatively small thickness t (x, y) of the body. Thus, the load resultants 
acting in the midplane, that is, the continuous line load p(x,y) and body load b(x,y), are independent of 
z. Under these conditions, it is enough to consider only the displacement functions of the points on the 
midplane of the body 
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Fig. 7.1 The midplane of the body and a 2D finite element (hrúbka = thickness) 
 

The non-zero components of the stress tensor placed in the column vector σ  are only the components 
that lie in the plane (x, y)  

T
x y z     σ                                                       (7.2) 

Hence, we say that the body (wall, membrane) is in a plane stress state. 

     In the column vector ε  of the strain components,  we will also consider only three components (In fact 
material reacts to the plane stress state by the transverse deformation z , but this can be determined from 
the deformations in the midplane.) 
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After simplifications 
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the strains in the plane (x,y) are given by 
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From the physical (material) equations we have 
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and from the condition 0z   
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Inverting  (7.6) we get the stress components 
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Now the strain z  can be expressed by substitution  (7.8) to (7.7)  

  
1z x y
  


  


 (7.9) 

The physical (constitutive) relationships in the matrix form are given by 
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In the equations above  E  is the Young modulus,   denotes the Poisson ratio and 
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is the shear modulus of the material. 

7.2  Von Mises plane stress isotropic small strain plasticity with the linear hardening 

     In this case, we again consider only those strain components that lie in the midplane because z  can be 

expressed by using these components, and for the plastic strain p
z  , we consider an incompressible 

material at plastic yielding ( 0.5  ). Thus, we have  
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where the splitting of z  into elastic and plastic parts is introduced based on the assumption of small strain. 

     We need the von Mises equivalent stress     for the plasticity condition  

 ( ) 0p
kf       (7.13) 

which at the plane stress state has form 

 2 2 23x y x y xy          (7.14) 

where ( )p
k   is the uniaxial hardened yield stress, which is a function of the accumulated plastic strain 

p . 

Then the vector of plastic yielding is given by 
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7.3 Stress increment specification  

     For the elastic test (trial) stress in the numerical incremental integration step from n to 1n  we have  
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and the equations of stress components after the stress point projection onto the updated yield surface are  
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where   is the unknown incremental plastic multiplier. 

     After an arrangement of equations (7.17), we get 
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The unknown plastic multiplier   has to satisfy the plasticity condition  (7.13) 
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where for  a linear hardening material the hardened yield stress k is  
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depending on the initial yield stress k , the accumulated plastic strian p , and the hardening modulus  
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where tE  is the elastoplastic tangent modulus. 

     The relationship for the   determitation has a more simple form when one uses the square of the 
condition (7.19) 
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Squaring the von Mises stress    (7.14)  we get  
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and after substituting (7.18)  
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Then the auxiliary function q (7.22) is given by    
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     The nonlinear equation (7.25), in fact, the other form of the consistency condition (7.13), enables us to 

solve   using the Newton-Raphson iteration. Decomposition of the function q in the reduced Tylor series 
gives the iterative relationship  
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where q is the derivative of function q by   and which form according to (7.25) and (7.20) is as follows 
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From (7.24) after extraction and differentiation by   we get the last needed relationship for the iterative 
procedure  
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     The calculation of   and the resulting stress 1n  are shown in the following example (the numerical 
results were calculated using the Mathematica 7 program, as shown in Fig. 7.2). 
 
Example 7.1 

     Consider a body made of steel material and loaded with plane stress. Its properties were approximated 
using the von Mises loading function and linear hardening model. Consider a material particle, which 
previous state is without stress, deformed by strains 0,002x  , 0,001y    and 2 0,002xy xy    and 

determine from the explicit relationships given above the final values of the stress components  in the next 
integration step, that is, 1n . Given is E = 200000 MPa, k = 200 MPa, the linear elastoplastic tangent 

modulus tE  100000 MPa,  = 0,3. The required accuracy was 1 1 0,001n n kf       MPa. 
 
Solution 

The test stress (7.16) is 
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Test of plasticity condition (7.13) gives 
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= 501,1 MPa  k  = 200 MPa 

     Because the test elastic stress 0   is  greater than the initial yield stress k  of the material point in the 

investigation, it follows that an elastic-plastic deformation will occur. The resulting stress in such case must 

be determined from backward integration relationships.  



     The initial values for the calculation of stress at the elastic-plastic loading were 0 0   and  

0 200k k   . Then, according to (7.24) - (7.28),  the iterative calculation was performed by the 
program (the used relations do not contain matrices, and so we have chosen program Mathematica 7), 
as shown in Fig. 7.2. 

     The components of the resulting stress at the investigated point of the body are as follows: 
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The resulting (hardened) yield stress of the material and resulting the equivalent plastic strain are as 
follows: 

1 342,7 MPakn    
-47,135 10p   

(* Backward-Euler, Plane stress - explicitly *) 
Off[General::spell,General::spell1] 
 
(* Input values *) 
EE=200000; mi=0.3; Sigk0=200; G=EE/(2+2*mi); Et=100000; H=EE*Et/(EE-Et); 
 
(* Start point *) 
sxn=0; 
syn=0; 
sxyn=0; 
 
(* Deformation increment *) 
EpsX= 0.002; 
EpsY=-0.001; 
EpsXY=0.002; 
 
(* Elastic trial stress *) 
K=EE/2/(1-mi); 
K1=EE/(1-mi^2); 
sx0=sxn+K1*(EpsX+mi*EpsY); 
sy0=syn+K1*(EpsY+mi*EpsX); 
sxy0=sxyn+K1/2*(1-mi)*EpsXY; 
 
(* Initial values of iteration *) 
La=0; 
Sigk=Sigk0; 
Sekv=0; 
c1=(sx0+sy0)^2;  
c2=3*(sx0-sy0)^2+12*sxy0^2; 

(* Iterative correction *) 
While [Abs[Sigk-Sekv]>0.001, 
Sekv2=0.25*(c1/(1+K*La)^2+c2/(1+3*La*G)^2); 
q=Sekv2-Sigk^2; 
Sekv=Sqrt[Sekv2]; 
dSekv=-1/(Sekv)*(K*c1/(1+K*La)^3+3*G*c2/(1+3*G*La)^3); 
dq=2*Sekv*dSekv-2*Sigk*(H*Sekv+La*H*dSekv); 
La=La-q/dq; 
Sigk=Sigk0+H*La*Sekv 
]; 

(* Stess calculation *) 
A1=1+0.5*La*EE/(1-mi); 
A2=1+3*La*G; 
sps=(sx0+sy0)/A1; 
sms=(sx0-sy0)/A2; 
SXdef=(sps+sms)/2; 
SYdef=(sps-sms)/2; 
SXYdef=sxy0/A2; 

(* Value of the new yield stress *) 
SigkDef=Sigk; 

(* Equivalent plastic deformation *) 
EplastPruh=La*Sekv; 

Print["Výsledky"/TableForm[{{"SX =", SXdef,"MPa"}, 
                 {"SY =", SYdef,"MPa"}, 
                 {"SXY =", SXYdef,"MPa"}, 
                 {"SigK =", SigkDef,"MPa"}, 
                 {"EpsPlast =", EplastPruh} 
                 }]] 
 



 

Fig. 7.2 Mathematica 7 program and results of the example 7.1 solution (Výsledky = Results)  

Example 7.2 

The previous example was solved using ANSYS Mechanical APDL. 

Solution 

   The material particle of the body can be replaced by a single plane stress finite element of unit 
thickness with given material properties. The problem of the xy  input can be solved by placing the 

element edges in the directions of the main strains 1  and 2  for which we have  
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The example can be solved in the ANSYS interactive environment using the following steps: 

1. Job name 
Utility Menu>File>Change Jobname..., /FILNAM = PlaneStress1, OK; 

2. Element type 
Main Menu>Preprocessor>Element Type>Add/Edit/Delete,  Add..., Solid Quad 8 node 183, OK, Close; 

3. Material properties 
Linear 
Preprocessor>Material Props>Material Models, Structural, Linear, Elastic, Isotropic,  EX = 2E5, PRXY = 0.3, 

OK,  
Nonlinear 
Nonlinear, Inelastic, Rate Independent, Isotropic Hardening Plasticity, Mises Plasticity, Bilinear, Yield Strss = 

200, Tang Mod = 1E5, OK, Material, Exit; 
 
4. Element keypoints (numbering is automatic) 
Utility Menu>Work Plane>Offset WP by Increments..., Degrees = 16.845, 0, 0, OK; 
Utility Menu>Work Plane>Local Coordinate Systems>Create Local CS>At WP Origin..., OK; 
Preprocessor>Modeling>Create>Keypoints>In Active CS:    X = 0, Y = 0, Apply, 
                                                                                                        X = 1, Y = 0, Apply, 
                                                                                                        X = 1, Y = 1, Apply, 
                                                                                                        X = 0, Y = 1, OK; 
5. Element area 
Preprocessor>Modeling>Create>Areas>Arbitrary>Trough KPs: KP1,KP2,KP3,KP4, OK; 

6. Element creating  
Preprocessor>Meshing>Mesh Tool: Size Controls: Lines, Set: Pick All, NDIV = 1, OK; 
(Preprocessor>Meshing>Mesh Tool): Mesh, Pick All, Close; 

Výsledky

SX 265.994 MPa
SY 45.7719 MPa
SXY 103.922 MPa
SigK 342.669 MPa
EpsPlast 0.000713346



7. 1  and 2  input 

 Preprocessor>Modeling>Move/Modify>Rotate Node CS>To Active CS , Pick All; 
Main Menu>Solution>Define Loads>Apply>Structural>Displacement>On Nodes  

List of Items:  1, 8, 6, OK, UX, Value = 0, OK, On Nodes 
  1, 3, 2, OK, UY, Value = 0, OK, On Nodes 
  2, 5, 4, OK, UX, Value = 0.0023027, OK, On Nodes 
  6, 7, 4, OK, UY, Value = - 0.0013027, OK; 
 

 

8. Solution 
Main Menu>Solution>Analysis Type>Sol’n Controls...,Time at end of loadstep = 1, Number of substeps = 1, 

OK; 
Solution>Solve>Current LS, Solve Current Load Step, OK; 
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9. Stress results 
Main Menu>General Postproc>List Results> Nodal Solution..., Stress,  X-Component of stress, OK; 
 
 PRINT S    NODAL SOLUTION PER NODE 
  THE FOLLOWING X,Y,Z VALUES ARE IN GLOBAL COORDINATES                          
  
    NODE    SX          SY          SZ          SXY         SYZ         SXZ      
       1   265.99     -45.766      0.0000      103.92      0.0000      0.0000     
       2   265.99     -45.766      0.0000      103.92      0.0000      0.0000     
       4   265.99     -45.766      0.0000      103.92      0.0000      0.0000     
       6   265.99     -45.766      0.0000      103.92      0.0000      0.0000     
 

10. End of job 
Ansys Toolbar>Quit>Save Geom+Loads, OK; 
 
The results were identical to those of the analytical solution. 
 
7.4 Matrix formulation 

    The analytical determination of the stress state in the elastic-plastic load step is indeed an elegant and 
simple procedure; however, if we are interested in creating an FEM program for solving elastic-plastic plane 
stress problems, it is necessary to establish basic relations and save the necessary values for the next load 
step in the matrix form. In such case, the state variables are written to the column matrices (vectors) 
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where at the deformation variables we consider  tensor components for shear strain ( 2xy xy  ) and for 

the deviatoric stress component we will implement 
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Now we can express the von Mises equivalent stress (7.14) as follows 
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The plasticity condition (7.13) is given by 
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and its preferred squared form is  

 21 1
2 2 3 ( ) 0T p

kf    P   (7.34) 

     The easiest way to get the increment of the plastic deformation vector is by using the formula for 
deriving the scalar quadratic form  
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where for the vector of plasticity in this case we have 
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The increment of plastic deformation is 
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In an increment step from time nt  to time 1nt  ,  the values of the elastic predictor are  
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 (7.38) 

where   is the known linear strain increment calculated from the load increment. In (7.38) all values are 
known, and we can check the plasticity condition (7.34). First, we calculate 
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If 2 0testf  , then the test values are valid for this (elastic) load step; otherwise, these values must be 
returned to the changed plasticity area using the plastic corrector. 

7.5 Equations for the return of the stress point on the yield area (plastic corrector) 

     The first equation, which the unknow stress 1n  have to fulfill at a plastic load step, is the condition 

(7.34) at the time 1nt    
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The equivalent plastic deformation in the load step will change by the increment (7.37) to 
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and the last equation in this system of nonlinear equations is the implicit relationship of the backward Euler 
method for calculation of the elastic deformation  
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     After a suitable arrangement the system of equations (7.40) to (7.42) can be changed to only one 
nonlinear equation with only one unknown  .  Startin with the elastic constitutive equations [1] 
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 gradually we get  
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With the known   it is possible, according to (7.44), to calculate the stress components from 
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or, because 1 1( )test e p
n n n  D    , from 
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where 
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7.6 Specifying the plastic multiplier from the consistency condition 

     There is only one unknown in the above equations, namely the plastic multiplier  . Its value must 
fulfill the consistency condition (7.40). Direct substitution of the matrix relations for 1n  (7.46) under this 
condition leads to an unpleasant matrix form of a nonlinear equation; therefore, it is better to use an 
explicit form, the derivation of which is presented in this section. In the case of isotropic elastic material, 

the matrices  eD and P  have the same eigenvectors, and it is possible to change them to diagonal by their 
orthogonal transformation in the plasticity condition, and thus obtain an explicit equation form suitable for 
calculation. The transformation relations are 
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where 
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and eD is given by (7.10).  

From (7.44) we get 
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Substituting (7.50) into the consistency condition (7.40) gives the simplified explicit equation 
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where 
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For the yield stress at the end of the load step we have 
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The last problem is to calculate   from the nonlinear equation  (7.52) . 

7.7 Determination of the plastic multiplier by the Newton-Raphson method 

     We are searching for the value of the plastic multiplier at which the equation (7.52) will be fulfilled with 
sufficient accuracy. In other words at the Newton-Raphson method the value of   has to change in such 
way that function 
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converges to zero. The classical iterative formula for an equation with one unknown in our case gives  
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where  
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The partial derivatives needed for 'q  can be determined from (7.53) and (7.54) 
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7.8  Matrix relations in Fortran 

     In the FEM programs above relationships are written in the form of a subroutine which is called in the 
cycle for each integration element point  of the body model. To conclude this section, we show such a 



subroutine in the  form of an executable program. The program is based on the above relations and should 
be comprehensible for people with elementary knowledge of FORTRAN language. The program solves the 
same example as that solved above with other programs (examples 1 and 2). 

      PROGRAM RETURN 
C************************************************** 
C     Stress point return on the plasticity area * 
C************************************************** 
      IMPLICIT DOUBLE PRECISION (A-H,O-Z) 
      DIMENSION 
     1    STRES(3) ,SVECT(3), EPS(3),  
     2    A(3,3),B(3,3),P(3,3),D(3,3) 
      DATA R0   ,R1   ,R2   ,R3   ,R4   ,R6    
     1    /0.D0 ,1.D0 ,2.D0 ,3.D0 ,4.D0 ,6.D0 / 
      DATA ALLOW / 0.00001D0 / 
 100  FORMAT(/' The maximum number of iterations was exceeded/) 
 200  FORMAT(' Medza sklzu =',F10.2) 
 300  FORMAT(' Napatia SX, SY, SXY =',3F10.2) 
      ROOT3 = SQRT(R3) 
      DLAMBDA = R0 
      I = 0 
      EPEKV = 0.0D0 
      E = 2.0D5 
      POIS = 0.3D0 
      F = E/(R3*(R1-POIS)) 
      G = E/(R2*(R1+POIS)) 
      CALL MATICA(D) !Matrix De calculation 
      EPS(1) = 2.0D-3 !Given components of the deformation increment 
      EPS(2) = -1.0D-3 
      EPS(3) = 2.0D-3 
      STRES(1) = D(1,1)*EPS(1)+D(1,2)*EPS(2) !Components of the trial stress 
      STRES(2) = D(2,1)*EPS(1)+D(2,2)*EPS(2) 
      STRES(3) = D(3,3)*EPS(3)  
      H = 2.0D5  !the hardening modulus 
      SIGK0 = 2.0D2 !the initial yield stress 
      A1 = (STRES(1)+STRES(2))*(STRES(1)+STRES(2)) 
      A2 = (STRES(1)-STRES(2))*(STRES(1)-STRES(2)) 
      A3 = R2*STRES(3)*STRES(3) 
      DLAMBDA = R0 
      EPSTN = EPEKV 
      SQ2D3 = SQRT(R2/R3) 
      I = 0 
  210 I = I+1 !Iteration cycle of the DeltaLambda calculation by N-R metod 
      D1 = R1+DLAMBDA*F 
      D2 = R1+R2*DLAMBDA*G 
      FI = A1/(R6*D1*D1)+A2/(R2*D2*D2)+A3/(D2*D2) 
      FI = SQRT(FI) 
      DFI = -R2*A1*F/(R6*D1*D1*D1)-R4*A2*G/(R2*D2*D2*D2) 
     1      -R4*A3*G/(D2*D2*D2) 
      DFI = DFI/(R2*FI) 
      EPEKV = EPSTN+DLAMBDA*FI*SQRT(R2/R3) 
      SIGK = SIGK0+H*EPEKV 
      DSIGK = H*SQ2D3*(FI+DLAMBDA*DFI) 
      GFCIA = FI*FI/R2-SIGK*SIGK/R3 
      DGFCIE = FI*DFI-R2*SIGK*DSIGK/R3 
      DLAMBDA = DLAMBDA-GFCIA/DGFCIE 
      IF(GFCIA.GT.ALLOW) GOTO 210 
      IF(I.GT.50)write(*,100)  
C  
      P(1,1) = R2/R3  !P matrix 
      P(1,2) = -R1/R3 
      P(1,3) = R0 
      P(2,1) = -R1/R3 
      P(2,2) = R2/R3 
      P(2,3) = R0 
      P(3,1) = R0 
      P(3,2) = R0 
      P(3,3) = R2 
      CALL INVERT(D,A)  
      DO 220 I = 1,3 
      DO 220 J = 1,3 
      D(I,J) = A(I,J)+DLAMBDA*P(I,J) 
  220 CONTINUE 
      CALL INVERT(D,B) 
      DO 230 I = 1,3 
      DO 230 J = 1,3 
      D(I,J) = R0 
      DO 230 K = 1,3 
      D(I,J) = D(I,J)+B(I,K)*A(K,J) 
  230 CONTINUE 
      DO 240 I = 1,3  !Stress calculation 
      SVECT(I) = R0 
      DO 240 J = 1,3 
      SVECT(I) = SVECT(I)+D(I,J)*STRES(J) 
  240 CONTINUE 
      DO 250 I = 1,3 
      STRES(I) = SVECT(I) 
  250 CONTINUE 
      STRES(4) = R0 
C     Printing results on the monitor screen       
 write(*,300)stres(1),stres(2),stres(3)   



 write(*,200)SIGK  !Yield s
  STOP 
      END 
  
      SUBROUTINE MATICA(D) 
      IMPLICIT DOUBLE PRECISION (A
  
      DIMENSION  D(3,3) 
      DATA R0,R1,R2/0.0D0,1.0D0,2.0D0/
      E = 2.0D5 
      POIS = 0.3D0 
      DO 10 ISTRE=1,3 
      DO 10 JSTRE=1,3 
   10 D(ISTRE,JSTRE)=R0 
      CONST=E/(R1-POIS*POIS) 
      D(1,1)=CONST 
      D(2,2)=CONST 
      D(1,2)=CONST*POIS 
      D(2,1)=CONST*POIS 
      D(3,3)=(R1-POIS)*CONST/R2 
      RETURN 
      END 
 
      SUBROUTINE INVERT(A,B) 
      IMPLICIT DOUBLE PRECISION (A
      DIMENSION A(3,3),B(3,3) 
      A11 = A(1,1) 
      A12 = A(1,2) 
      A13 = A(1,3) 
      A21 = A(2,1) 
      A22 = A(2,2) 
      A23 = A(2,3) 
      A31 = A(3,1) 
      A32 = A(3,2) 
      A33 = A(3,3) 
      T1  = A22*A33 - A32*A23 
      T2  = A23*A31 - A21*A33 
      T3  = A21*A32 - A22*A31 
      DETER = A11*T1 + A12*T2 + A13*T3
      IF(DETER.EQ.0.0) stop 
      DENOM = 1./DETER 
      B(1,1) = T1*DENOM 
      B(2,1) = T2*DENOM 
      B(3,1) = T3*DENOM 
      B(1,2) = (-A12*A33 + A32*A13)*DENOM
      B(2,2) = ( A11*A33 - A31*A13)*DENOM
      B(3,2) = (-A11*A32 + A12*A31)*DENOM
      B(1,3) = ( A12*A23 - A13*A22)*DENOM
      B(2,3) = (-A11*A23 + A21*A13)*DENOM
      B(3,3) = ( A11*A22 - A21*A12)*DENOM
      RETURN 
      END 

Results (Napatia = Stresses, Medza sklzu = Yield stress)

 

7.9 Consistent tangent material modulus

     The global tangential stiffness matrix of an FE model is created by an organized summation of its 
element tangential stiffness matrices
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     The consistent linearization of the local material element matrices  produces the global tangent  stiffness 
matrix in such a form, which guarantees the quadratic convergence of the global Newton-Raphson iteration 
in the load step. 

     The derivation of the D  matrix begins with differentiation of expression for stress (7.43)  
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and after similar arrangements as at (7.43) we get 
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It remains to express d   in (7.64)  from the consistency condition. 

       Differentiation of the consistency condition (7.40) gives (note: ( ) 2T Td dx x x x ) 
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From (7.41) we have 
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By substituting (7.66) in (7.65) we have 
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and after substitute a we get a simplified equation 
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Substitution (7.64) into (7.68) gives the following relationship 
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and from this equation the wanted differential is given by 
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The use of  d   in  (7.64) gives the resulting expression for the stress increment  
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     Thus, if an FEM program for solving the elastic-plastic plane stress problem uses the incremental 
calculation of the stress according to equations (7.43) to (7.46),  then to ensure the quadratic convergence 
of the Newton-Raphson method at the solution of the global nonlinear system, it is necessary to use the 



material modulus (7.72) at the tangential element matrices (7.60) calculation. Use of the classical tangential 
material modulus (so-colled elastoplastic continuum tangent operator)  
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leads to a rapid decline in convergence.  
 
7.10 Consistent material modulus computation in FORTRAN.  

    According to the relationships in the previous section, we processed the program MATMODUL2D for a 
consistent tangential material modulus with linear isotropic hardening in FORTRAN. In a real FEM program, 
such a part acts as a subroutine called for every integral point from the subroutine, which calculates 
the tangential element stiffness matrices. The input variables come to such subroutine as parameters of 
the calling command, but in this program illustration, we have input them directly in the program part 
noted as Input values.  
 
      PROGRAM MATMODUL2D 
C*************************************************** 
C     CONSISTENT MATERIAL MODULUS VON MISES 2D  * 
C*************************************************** 
      IMPLICIT DOUBLE PRECISION (A-H,O-Z) 
      DIMENSION 
     1    D(3,3),A(3,3),P(3,3),AVECT(3),BVECT(3), 
     3    STRES(3),B(3,3) 
      DATA R0     ,R1     ,R2     ,R3     ,R4     ,R9 
     1    /0.0D0  ,1.0D0  ,2.0D0  ,3.0D0  ,4.0D0  ,9.0D0/ 
 
C Input values 
      E=2.0D5 
      H=2.0D5 
      POIS=R0 
      DLAMBDA=6.6851D-4 
      STRES(1)=385.3D0 
      STRES(2)=197.9D0 
      STRES(3)=R0 
      SIGEF=333.7D0 
      SIGK=333.7D0 
C 
      BETA  = R1-H*DLAMBDA/(R3*SIGEF) 
      DO 10 I=1,3 
      DO 10 J=1,3 
   10 D(I,J)=R0 
C Elastic matrix De calculation 
      CONST=E/(R1-POIS*POIS) 
      D(1,1)=CONST 
      D(2,2)=CONST 
      D(1,2)=CONST*POIS 
      D(2,1)=CONST*POIS 
      D(3,3)=(R1-POIS)*CONST/R2 
      D(4,4)=R1 
C P-matrix           
      P(1,1) = R2/R3 
      P(1,2) = -R1/R3 
      P(1,3) = R0 
      P(2,1) = -R1/R3 
      P(2,2) = R2/R3 
      P(2,3) = R0 
      P(3,1) = R0 
      P(3,2) = R0 
      P(3,3) = R2 
C Expanded D-matrix 
      CALL INVERT(D,A) 
      DO 120 I=1,3 
      DO 120 J=1,3 
      B(I,J) = A(I,J)+DLAMBDA*P(I,J) 
  120 CONTINUE 
      CALL INVERT(B,A) 
C Consistent tangential matrix calculation 
      DO 140 I=1,3 
      AVECT(I) = R0 
      DO 140 J=1,3 
      AVECT(I) = AVECT(I)+P(I,J)*STRES(J) 
  140 CONTINUE 
      DO 150 I=1,3 
      BVECT(I) = R0 
      DO 150 J=1,3 
      BVECT(I) = BVECT(I)+A(I,J)*AVECT(J) 
  150 CONTINUE 
      RMENOV = R0 
      DO 160 I=1,3 
  160 RMENOV = RMENOV+AVECT(I)*BVECT(I) 
      BETA = R1-R2*H*DLAMBDA/R3 



      H2 = R4*H*SIGK*SIGK/(R9*BETA)
      RMENOV = RMENOV+H2 
      DO 170 I=1,3 
      DO 170 J=1,3 
      B(I,J) = BVECT(I)*BVECT(J) 
  170 CONTINUE 
      DO 180 I=1,3 
      DO 180 J=1,3 
      D(I,J) = A(I,J)-B(I,J)/RMENOV 
  180 CONTINUE 
      WRITE(*,11) 
      WRITE(*,12)D 
   11 FORMAT( ' D = ') 
   12 FORMAT(3f15.3)  
      STOP 
      END 

The calculated consistent tangential modulus

     Table 1 presents the results of
the effectiveness of using  the tangential
column), where Fnroma is the norm of the residu

two columns in the table indicate
classical modulus  of continuous integrati
criterion Fnorma should fall below 0.001.

     Table 7.1 Iteration steps at different modules

Elastic material modulus

ite = 1 
 Fnorma = 81.9361     
 ite = 2 
 Fnorma = 45.0528     
 ite = 3 
 Fnorma = 24.1507     
 ite = 4 
 Fnorma = 12.7373     
 ite = 5 
 Fnorma = 6.64959     
 ite = 6 
 Fnorma = 3.44982     
 ite = 7 
 Fnorma = 1.78315     
 ite = 8 
 Fnorma = .919702     
 ite = 9 
 Fnorma = .473786     
 ite =10 
 Fnorma = .243908     
 ite =11 
 Fnorma = .125520     
 ite =12 
 Fnorma = .645826E-01 
 ite =13 
 Fnorma = .332255E-01 
 ite =14 

H2 = R4*H*SIGK*SIGK/(R9*BETA) 

 

B(I,J)/RMENOV  

tial modulus is as follows: 

 

results of the iterative procedure of the test program,
the tangential material modulus consistent with the integration

is the norm of the residual forces and ITE is the number of iteration 

in the table indicate these values using the elastic material modulus
integration contD . During the integration procedures

should fall below 0.001.  

Iteration steps at different modules 

Elastic material modulus De Modulus Dcont Consistent modulus

 

 

ite = 1 
 Fnorma = 81.9361     
 ite = 2 
 Fnorma = 18.1286     
 ite = 3 
 Fnorma = 6.25226     
 ite = 4 
 Fnorma = 1.70708     
 ite = 5 
 Fnorma = .430342     
 ite = 6 
 Fnorma = .104781     
 ite = 7 
 Fnorma = .250916E-01 
 ite = 8 
 Fnorma = .595902E-02 
 ite = 9 
 Fnorma = .140928E-02 
 ite =10 
 Fnorma = .332571E-03 
 

ite = 1 
 Fnorma = 81.9361    
 ite = 2 
 Fnorma = 4.06090    
 ite = 3 
 Fnorma = .142896E
 ite = 4 
 Fnorma = .113480E
 

program, which illustrates 
integration procedure (third 

is the number of iteration steps. The first 

modulus eD  and the 
the integration procedures, the convergence 

Consistent modulus Dcons 

Fnorma = 81.9361     

Fnorma = 4.06090     

Fnorma = .142896E-02 

Fnorma = .113480E-06 



 Fnorma = .170925E-01 
 ite =15 
 Fnorma = .879277E-02 
 
ITERATION NUMBER       =    15 
 The limit number of iterations 
was exceeded 
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